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Abstract 
Student get brief knowledge of Computer Generation, Hardware, Software and numbering 

System. 
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Chapter 1 (Introduction of Computer) 

 

What is Computer? 

A computer is a programmable machine designed to perform 

arithmetic and logical operations on data using pre-defined 

instruction set given by humans and gives the desired output 

after processing.  

कंपू्यटर एक प्रोग्राम करने योग्य मशीन है जिसे मानव द्वारा जिए गए पूवव-जनर्ावररत जनिेश सेट का उपयोग करके डेटा पर 

अंकगजित और ताजकव क संचालन करने के जलए जडजाइन जकया गया है और प्रसंस्करि के बाि वांजित आउटपुट िेता है। 

Data – It is the combination of raw facts and figures. 

डेटा - यह कचे्च तथ्यों और आोंकडयों का सोंययजन है। 

Processing – It is totally internal work of computer system in which computer does some arithmetic 

and logical operations on data. 

प्रयसेससोंग - यह पूरी तरह से कों पू्यटर ससस्टम का आोंतररक कायय है सजसमें कों पू्यटर डेटा पर कुछ अोंकगसितीय और तासकय क 

सोंचालन करता है। 

Information – After processing of data given output by the computer is an information. 

सूचना - डाटा के प्रसंस्करि के बाि कंपू्यटर द्वारा जिया गया आउटपुट एक सूचना है। 

Function of Computer 

 

 

Characteristics of computers 

The main characteristic of computer is speed, accuracy, diligence, versatility and it’s storage 

capacity. 

कों पू्यटर की मुख्य सिशेषता गसत, सटीकता, पररश्रम, बहुमुखी प्रसतभा और इसकी भोंडारि क्षमता है। 

Speed -  Computers work at an incredible speed. A powerful computer is capable of performing 

about 3-4 million simple instructions per second.  

Figure 1 – Computer System 

Data (Input) Process Information(Ouput)

https://www.youtube.com/junctionofgyan
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गसत - कों पू्यटर असिश्वसनीय गसत से काम करते हैं। एक शक्तिशाली कों पू्यटर प्रसत सेकों ड लगभग 3-4 समसलयन सरल सनरे्दश 

करने में सक्षम है। 

Accuracy - In addition to being fast, computers are also accurate. Errors that may occur can almost 

always be attributed to human error (inaccurate data, poorly designed system or faulty 

instructions/programs written by the programmer)  

शुद्धता - तेि होने के साथ-साथ कंपू्यटर सटीक भी होते हैं। िो तु्रजटयां हो सकती हैं, उन्हें लगभग हमेशा मानवीय तु्रजट के 

जलए जिमे्मिार ठहराया िा सकता है (गलत डेटा, खराब जडजाइन की गई प्रिाली या प्रोग्रामर द्वारा जलखे गए िोषपूिव 

जनिेश/कायवक्रम) 

Diligence - Unlike human beings, computers are highly consistent. They do not suffer from human 

traits of boredom and tiredness resulting in lack of concentration. Computers, therefore, are better 

than human beings in performing voluminous and repetitive jobs.  

पररश्रम - मनुष्य के जवपरीत, कंपू्यटर अत्यजर्क सुसंगत हैं। वे ऊब और थकान के मानवीय लक्षिो ंसे ग्रस्त नही ंहोते हैं 

जिसके पररिामस्वरूप एकाग्रता की कमी होती है। इसजलए, कंपू्यटर बडे पैमाने पर और िोहराव वाले कायों को करने में 

इंसानो ंसे बेहतर हैं। 

Versatility - Computers are versatile machines and are capable of performing any task as long as it 

can be broken down into a series of logical steps. The presence of computers can be seen in almost 

every sphere – Railway/Air reservation, Banks, Hotels, Weather forecasting and many more.  

बहुमुखी प्रसतभा - कों पू्यटर बहुमुखी मशीनें हैं और सकसी भी कायय कय तब तक करने में सक्षम हैं जब तक इसे तासकय क चरियों 

की एक श्ररोंखला में तयडा जा सकता है। कों पू्यटर की उपक्तथिसत लगभग हर के्षत्र में रे्दखी जा सकती है - रेलिे / हिाई आरक्षि, 

बैंक, हयटल, मौसम पूिायनुमान और कई अन्य। 

Storage Capacity -Today’s computers can store large volumes of data. A piece of information once 

recorded (or stored) in the computer, can never be forgotten and can be retrieved almost 

instantaneously. 

भोंडारि क्षमता - आज के कों पू्यटर बडी मात्रा में डेटा स्टयर कर सकते हैं। कों पू्यटर में एक बार र्दजय (या सोंग्रहीत) जानकारी का 

एक टुकडा, कभी नही ों भुलाया जा सकता है और लगभग तुरों त प्राप्त सकया जा सकता है। 

Limitations of computer 

The main limitations of computer are no I.Q and Feelings. 

कों पू्यटर की मुख्य सीमाएँ हैं - बुक्ति और भािना की कमी । 

https://www.youtube.com/junctionofgyan
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Uses of computers 

Now these days’ computers are used in every fields such as Education, Research and Development, 

Weather Forecasting, Publishing, Defence, Scientific works, entertainment and in the making of 

movies also.  

आजकल कों पू्यटर का उपययग हर के्षत्र में सकया जाता है, जैसे सशक्षा, अनुसोंधान और सिकास, मौसम पूिायनुमान, प्रकाशन, रक्षा, 

िैज्ञासनक कायय, मनयरोंजन और सिल्में बनाने में भी। 

Computer Systems Organization 

 

 

Figure 2 – Computer System  
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Chapter 2 – History of Computer 

 

Abacus - An abacus is a mechanical device used to aid an individual in performing mathematical 

calculations.  It was invented in Babylonia in 2400 B.C. It used to perform basic arithmetic 

operations. 

अबेकस - एक अबेकस एक याोंसत्रक उपकरि है 

सजसका उपययग सकसी व्यक्ति कय गसितीय गिना 

करने में सहायता करने के सलए सकया जाता है। इसका 

आसिष्कार बेबीलयसनया में 2400 ईसा पूिय में हुआ िा। 

यह बुसनयार्दी अोंकगसितीय सोंचालन करता िा। 

Napier’s Bones - Invented by John Napier in 1614. 

Allowed the operator to multiply, divide and calculate 

square and cube roots by moving the rods around and 

placing them in specially constructed boards. 

1614 में जॉन नेसपयर द्वारा खयजी गई। ऑपरेटर कय छडयों कय चारयों 

ओर घुमाकर और सिशेष रूप से सनसमयत बयडों में रखकर िगय और 

घनमूलयों कय गुिा, सिभासजत और गिना करने की अनुमसत र्दी। 

Slide Rule - Invented by William Oughtred in 1622. It is based on Napier's ideas about logarithms. 

Used primarily for multiplication, division, roots, logarithms, Trigonometry. Not normally used for 

addition or subtraction. 

1622 में सिसलयम ऑउटर ेड द्वारा आसिष्कार सकया 

गया। यह नेसपयर के लघुगिक के सिचारयों पर 

आधाररत है। मुख्य रूप से गुिन, सिभाजन, मूल, 

लघुगिक, सत्रकयिसमसत के सलए उपययग सकया जाता 

है। आमतौर पर जयड या घटाि के सलए उपययग नही ों  

सकया जाता है। 

Pascaline  - Invented by Blaise Pascal in 1642. It was its limitation to addition and subtraction. It 

was too expensive. 

1642 में बे्लज पास्कल द्वारा आजवष्कार जकया गया। यह इसके िोड  

और घटाव की सीमा थी। यह बहुत महंगा था। 

Figure 3 - Abacus 

Figure 4 - Napier’s Bones 

Figure 5 - Slide Rule 

Figure 6 - Pascaline 

https://www.youtube.com/junctionofgyan
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Stepped Reckoner - Invented by Gottfried 

Wilhelm Leibniz in 1672. The machine that 

can add, subtract, multiply and divide 

automatically. 

1672 में गॉटफ्राइड सिले्हम लाइबसनज द्वारा 

आसिष्कार सकया गया। िह मशीन जय स्वचासलत रूप  

से जयड, घटा, गुिा और सिभासजत कर सकती है। 

Jacquard Loom - The Jacquard loom is a  

mechanical loom, invented by Joseph-Marie 

Jacquard in 1881. It an automatic loom controlled by 

punched cards. 

िैक्वाडव  लूम एक यांजत्रक करघा है, जिसका आजवष्कार िोसेफ-

मैरी िैक्वाडव ने 1881 में जकया था। यह एक स्वचाजलत करघा है 

जिसे पंच काडव द्वारा जनयंजत्रत जकया िाता है। 

Arithmometer - A mechanical calculator 

invented by Thomas de Colmar in 1820. The 

first reliable, useful and commercially 

successful calculating machine. The machine 

could perform the four basic mathematic 

functions. The first mass-produced calculating 

machine.  

1820 में िॉमस डी कयलमार द्वारा आसिष्कार सकया गया 

एक याोंसत्रक कैलकुलेटर। पहली सिश्वसनीय, उपययगी और 

व्यािसासयक रूप से सिल गिना मशीन। मशीन चार 

बुसनयार्दी गसितीय कायय कर सकती िी। पहली बडे पैमाने 

पर उत्पासर्दत गिना मशीन। 

Difference Engine and Analytical Engine - It an  

automatic, mechanical calculator designed to 

tabulate polynomial functions. Invented by Charles 

Babbage in 1822 and 1834. It is the first mechanical 

computer. 

Figure 7 – Stepped Reckoner 

Figure 8 – Jacquard Loom 

Figure 9 Arithmometer 

Figure 10 - Difference Engine 

https://www.youtube.com/junctionofgyan
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 First Computer Programmer - In 1840, Augusta 

Ada Byron suggests to Babbage that he use the 

binary system. She writes programs for the 

Analytical Engine. 

 यह एक स्वचासलत, याोंसत्रक कैलकुलेटर है सजसे बहुपर्द कायों 

कय सारिीबि करने के सलए सडजाइन सकया गया है। 1822 और 

1834 में चार्ल्य बैबेज द्वारा आसिष्कार सकया गया। यह पहला 

याोंसत्रक कों पू्यटर है। 

Tabulating Machine - Invented by Herman 

Hollerith in 1890. To assist in summarizing 

information and accounting. 

1890 में हरमन हयलेररि द्वारा आसिष्कार सकया गया। 

सूचना और लेखाोंकन कय साराोंसशत करने में सहायता 

करने के सलए। 

Havard Mark 1 - Also known as IBM Automatic 

Sequence Controlled Calculator (ASCC). Invented  

by Howard H. Aiken in 1943. The first electro- 

mechanical computer. 

आईबीएम स्वचाजलत अनुक्रम जनयंजत्रत कैलकुलेटर (एएससीसी) 

के रूप में भी िाना िाता है। 1943 में हॉवडव  एच। ऐकेन द्वारा 

आजवष्कार जकया गया। पहला इलेक्ट्र ो-मैकेजनकल कंपू्यटर। 

ENIAC - ENIAC stands for Electronic 

Numerical Integrator and Computer. It was the 

first electronic general-purpose computer.  

Completed in 1946. Developed by John 

Presper Eckert and John W. Mauchly. 

ENIAC का मतलब इलेक्ट्र ॉजनक नू्यमेररकल इंटीगे्रटर और 

कंपू्यटर है। यह पहला इलेक्ट्र ॉजनक सामान्य प्रयोिन वाला 

कंपू्यटर था। 1946 में पूरा हुआ। िॉन पे्रस्पर एकटव और 

िॉन डबू्ल्य। मौचल द्वारा जवकजसत। 

Figure 11 Analytical Engine 

Figure 12 Tabulating Machine 

Figure 13 - Havard Mark 1 

Figure 14 ENIAC 

https://www.youtube.com/junctionofgyan
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UNIVAC 1 - The UNIVAC I (UNIVersal Automatic Computer 1) was the first commercial 

computer. • Designed by J. Presper Eckert and John Mauchly. 
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Chapter 3 (Generation of Computers And Types of Computer) 
Generation in computer terminology is a change in technology a computer is/was being used. There 

are five generations of computer. They are  

 First Generation : 1945 – 55  

 Second Generation : 1955 – 65  

 Third Generation : 1965 – 75  

 Fourth Generation : 1975 To Present 

 Fifth Generation : Yet To Come  

First Generation Computers 
The period of first generation was from 1946-1959. The computers of first generation used vacuum 

tubes as the basic components for memory and circuitry for CPU (Central Processing Unit). These 

tubes, like electric bulbs, produced a lot of heat and the installations used to fuse frequently. 

Therefore, they were very expensive and only large organizations were able to afford it. 

In this generation, mainly batch processing operating system was used. Punch cards, paper tape, and 

magnetic tape was used as input and output devices. The computers in this generation used machine 

code as the programming language. 

 

The main features of the first generation are − 

 Vacuum tube technology 

 Unreliable 

 Supported machine language only 

 Very costly 

 Generated a lot of heat 

 Slow input and output devices 

 Huge size 

 Need of AC 

 Non-portable 

 Consumed a lot of electricity 

Some computers of this generation were − 

 ENIAC 

 EDVAC 

 UNIVAC 

 IBM-701 

 IBM-650 

Vacuum Tube - 

Second Generation Computers 
The period of second generation was from 1959-1965. In this generation, transistors were used that 

were cheaper, consumed less power, more compact in size, more reliable and faster than the first 

https://www.youtube.com/junctionofgyan
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generation machines made of vacuum tubes. In this generation, magnetic cores were used as the 

primary memory and magnetic tape and magnetic disks as secondary storage devices. 

In this generation, assembly language and high-level programming languages like FORTRAN, 

COBOL were used. The computers used batch processing and multiprogramming operating system. 

 

The main features of second generation are − 

 Use of transistors 

 Reliable in comparison to first generation 
computers 

 Smaller size as compared to first 
generation computers 

 Generated less heat as compared to first 
generation computers 

 Consumed less electricity as compared to 
first generation computers 

 Faster than first generation computers 

 Still very costly 

 AC required 

 Supported machine and assembly languages 

Some computers of this generation were − 

 IBM 1620 

 IBM 7094 

 CDC 1604 

 CDC 3600 

 UNIVAC 1108 

Third Generation Computers 

The period of third generation was from 1965-1971. The computers of third generation used 
Integrated Circuits (ICs) in place of transistors. A single IC has many transistors, resistors, 
and capacitors along with the associated circuitry. 

The IC was invented by Jack Kilby. This development made computers smaller in size, 
reliable, and efficient. In this generation remote processing, time-sharing, multiprogramming 
operating system were used. High-level languages (FORTRAN-II TO IV, COBOL, PASCAL 
PL/1, BASIC, ALGOL-68 etc.) were used during this generation. 

 

The main features of third generation are − 

 IC used 

 More reliable in comparison to previous two generations 

 Smaller size 

 Generated less heat 

 Faster 

 Lesser maintenance 

https://www.youtube.com/junctionofgyan
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 Costly 

 AC required 

 Consumed lesser electricity 

 Supported high-level language 

Some computers of this generation were 
− 

 IBM-360 series 

 Honeywell-6000 series 

 PDP (Personal Data Processor) 

 IBM-370/168 

 TDC-316 

 

Fourth Generation Computers 

The period of fourth generation was from 1971-1980. Computers of fourth generation used 
Very Large Scale Integrated (VLSI) circuits. VLSI circuits having about 5000 transistors and 
other circuit elements with their associated circuits on a single chip made it possible to have 
microcomputers of fourth generation. 

Fourth generation computers became more powerful, compact, reliable, and affordable. As a 
result, it gave rise to Personal Computer (PC) revolution. In this generation, time sharing, real 
time networks, distributed operating system were used. All the high-level languages like C, 
C++, DBASE etc., were used in this generation. 

 

The main features of fourth generation are − 

 VLSI technology used 

 Very cheap 

 Portable and reliable 

 Use of PCs 

 Very small size 

 Pipeline processing 

 No AC required 

 Concept of internet was introduced 

 Great developments in the fields of 
networks 

 Computers became easily available 

Some computers of this generation were − 

 DEC 10 

 STAR 1000 

 PDP 11 

 CRAY-1(Super Computer) 

 CRAY-X-MP(Super Computer) 

https://www.youtube.com/junctionofgyan
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Fifth Generation Computers 
Those computers have ability to reason and decision making will be known as fifth generation 

computers. 

TYPES OF COMPUTERS 
 Present day computers can be categorized as below:  

Super Computer - Supercomputers are fastest computers and are very expensive. These are 

employed for specialized applications that require immense amounts of mathematical calculations. 

For example, weather forecasting requires a supercomputer. Other uses of supercomputers include 

animated graphics, fluid dynamic calculations, nuclear energy research, and petroleum 

exploration. 

Mainframe Computer - It is a very large and expensive computer and is capable of supporting 

hundreds, or even thousands of users simultaneously. In the hierarchy that starts with a simple 

microprocessor (in watches, for example) at the bottom and moves to supercomputers at the top, 

mainframes are just below supercomputers. In some ways, mainframes are more powerful than 

supercomputers because they support simultaneous programs. But, supercomputers can execute a 

single program faster than a mainframe. The chief difference between a supercomputer and a 

mainframe is that a supercomputer channels all its power into executing a few programs as fast as 

possible, whereas a mainframe uses its power to execute many programs concurrently.  

Mini Computer - It is a mid sized computer in size and power. It lies between workstations and 

mainframes. In the past decade, the distinction between large minicomputers and small 

mainframes has blurred. In general, a minicomputer is a multiprocessing system capable of 

supporting from 4 to about 200 users simultaneously.  

Micro Computer  

 Desktop Computer: a personal or micro-mini computer sufficient to fit on a desk.  

 Laptop Computer: a portable computer complete with an integrated screen and keyboard. It 

is generally smaller in size than a desktop computer and larger than a notebook computer. 

 Palmtop Computer/Digital Diary /Notebook /PDAs (Personal Digital Assistant): a hand-

sized computer, Palmtop, does not have keyboard, but its screen serves both as an input and 

output device.  

Workstations -  It is a terminal or desktop computer in a network. In this context, workstation is 

just a generic term for a user’s machine (client machine) in contrast to a “server” or “mainframe.” 
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Chapter 4 – Parts of Computer 
Computer system made of two major component hardware and software. 

Hardware 
All the tangible part of computers. That can be seen or touched. 

There are two parts of Hardware- 

 CPU 

 Peripheral Devices 

CPU: - CPU stands for Central Processing Unit. It is the brain of computer. All the arithmetic and 

logical work being done here. There are three parts of CPU – 

 CU (Control Unit) 

 ALU (Arithmetic Logical Unit) 

 MU (Memory Unit) 

CU (Control Unit) – CU responsible for controlling all activity happened in computer system. 

It’s control the flow of data through all the part of computer. 

ALU (Arithmetic Logic Unit) – All the arithmetic and logical calculation done here. 

MU (Memory Unit) – At the time ALU performs calculation, the data and instructions are stored 

here. MU also known as registers and it is fastest memory. 

Peripherals – All the devices attached to the CPU are known as Peripherals. There are three parts 

of peripherals. 

 Input Devices 

 Output Devices 

 Memory Devices 

 Input Devices – All the devices which are used for feeding data into the computer are known 

as Input Devices. Such as Keyboard, Mouse, Joystick, Touch Screen, OMR , MICR, 

Microphone, Barcode Reader, QR Reader, Scanner, Iris Scanner, Fingerprint Scanner. 

Output Devices – All the devices which are used show results after processing are known as 

output devices. Such as Monitor, Plotter, Speaker, Printer, Projector etc. 

Memory Devices – All the devices which are used to store data are known as memory devices. 

Such as Hard Disc, Floppy Disc, CD, DVD, Pen drive, Ram, Rom, Magnetic Tap etc.  

 There are two types of Memory Devices- 

 Primary Memory 

 Secondary Memory 

Primary Memory – All the memory which are directly used by CPU are known as Primary 

memory. Generally Primary memories are volatile in nature, made of semiconductors and 

internal memory. These are Expensive memories and used less in amount. There are two 

parts of primary memory. 

o RAM (Random Access Memory) 

o ROM (Read Only Memory) 
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Secondary memory – These are permanent memories and not directly used by processors. 

These are less expensive then primary memory and also known are auxiliary memories. Such 

as hard disc, floppy disc, cd, DVD, pen drive, memory cards. 

Software 
Software is simply a computer program or a set of instructions. Software guides the computer at 

every step indicating where to start and stop during a particular job. 

There are two types of software – 

 System Software 

 Application software 

System software - System Software are general purpose programs designed to perform tasks such 

as controlling all operations required to move data into and out of the computer. It communicates 

with keyboard, printer, card reader, disk, tapes, etc. It also monitors the use of various hardwares 

like memory, CPU, etc. System software acts as an interface between hardware and application 

software. Remember that it is not possible to run application software without system software. 

Some of the system software’s are Disc Operating System(DOS), Windows, Unix/Linux, MAC/OS 

X etc.  

Application software - It is a set of programs, which are written to perform specific tasks of the 

users of computer. These softwares are developed in high level languages to help the user to get the 

computer to perform various tasks. Some of the application software are MS Office, Macromedia 

(Dreamweaver, Flash, Freehand), Adobe (PageMaker, PhotoShop), LIBSYS, SOUL, WINISIS, 

KOHA, etc. 

 Presentation software: They allow the easy visual presentation of data with the help of 

various tools. Information can be presented easily in the form of slides. Ex – Ms- Powerpoint, 

LibreOffice Impress. 

 Spreadsheet software: Representation of data in tabular form is possible through 

spreadsheet software. They allow easy calculations through formulas and functions. Ex – 

Ms- Excel, LibreOffice Calc, Google Sheet. 

 Graphic software: Graphics software allows easy editing of visual data. It makes room for 

picture editing and illustration. 

 Word processors: Word processor software allows formulation, beautification, and 

manipulation of text. They allow a wide variety of features to make room for effective text 

consolidation and editing. Ms – Word, LibreOffice Writer 

 Database software: Known popularly as database management software, this software 

helps with effective data management. This software allows easy organization of data and 

effortless access to it. Ex – Ms – Access, Libreoffice Base, Dbase etc. 

 Multimedia software: Such software allows easy creation of audio, video, or pictorial files. 

They deal with all basic multimedia creation and sharing. They come with a wide variety of 

tools to facilitate the same. 

 Web browsers: As a software application, web browsers facilitate easy surfing of the 

internet. You can make use of these to quickly locate information across the web. 

 

https://www.youtube.com/junctionofgyan
https://www.youtube.com/junctionofgyan


 

  

P
ag

e1
5

(L
ex

ic
o

n
 In

d
ia

- 
9

6
6

1
2

8
0

0
3

8
) 

Utility Software 
The Utility Software is system software that helps to maintain the proper and smooth functioning of 

a Computer System. It assists the Operating System to manage, organize, maintain, and optimize 

the functioning of the computer system. Ex- Backup and Restore software, Antivirus Software. 

Virus - A virus is a fragment of code embedded in a legitimate program. Viruses are self-

replicating and are designed to infect other programs. They can wreak havoc in a system by 

modifying or destroying files causing system crashes and program malfunctions. 

 Worms - Worms is also a computer program like virus but it does not modify the program. 

It replicate itself more and more to cause slow down the computer system. Worms can be 

controlled by remote. 

 Trojan Horse - Trojan Horse does not replicate itself like virus and worms. It is a hidden 

piece of code which steal the important information of user. For example, Trojan horse 

software observe the e-mail ID and password while entering in web browser for logging. 
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Chapter 5 (Operating System) 
An Operating System is a system software that acts as an interface between a user and hardware of 

a computer. Modern operating systems usually feature a graphical user interface which uses a 

pointing device such as mouse or keyboard for input. Operating Systems are viewed as resource 

managers that manage the resources of a computer. The main resource is the computer hardware 

which is in the form of processors, storage, input/output devices, communication devices, and data. 

A good operating system should be efficient, reliable, take short time in execution of programs, 

occupy small memory as small as possible.  

The main Operating Systems are:  

1. Network Operating System –  

 WINDOWS 2000  

 Unix 

 Linux  

2. Desktop Operating System –  

 WINDOWS  

 DOS (Disc Operating System)  

 Mac OS  

3. Mobile Operating System –  

 Android 

 Palm OS  

 Pocket PC 

 IOS 
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Chapter 5 (Number System) 
The technique to represent and work with numbers is called number system. Decimal number 

system is the most common number system. Other popular number systems include binary number 

system, octal number system, hexadecimal number system, etc. 

Decimal Number System 
Decimal number system is a base 10 number system having 10 digits from 0 to 9. This means that 

any numerical quantity can be represented using these 10 digits. Decimal number system is also 

a positional value system. This means that the value of digits will depend on its position. Let us 

take an example to understand this. 

Say we have three numbers – 734, 971 and 207. The value of 7 in all three numbers is different− 

 In 734, value of 7 is 7 hundreds or 700 or 7 × 100 or 7 × 102 

 In 971, value of 7 is 7 tens or 70 or 7 × 10 or 7 × 101 

 In 207, value 0f 7 is 7 units or 7 or 7 × 1 or 7 × 100 

The weightage of each position can be represented as follows − 

 

In digital systems, instructions are given through electric signals; variation is done by varying the 

voltage of the signal. Having 10 different voltages to implement decimal number system in digital 

equipment is difficult. So, many number systems that are easier to implement digitally have been 

developed. Let’s look at them in detail. 

Binary Number System 
The easiest way to vary instructions through electric signals is two-state system – on and off. On is 

represented as 1 and off as 0, though 0 is not actually no signal but signal at a lower voltage. The 

number system having just these two digits – 0 and 1 – is called binary number system. 

Each binary digit is also called a bit. Binary number system is also positional value system, where 

each digit has a value expressed in powers of 2, as displayed here. 

 

In any binary number, the rightmost digit is called least significant bit (LSB) and leftmost digit is 

called most significant bit (MSB). 

 

And decimal equivalent of this number is sum of product of each digit with its positional value. 
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110102 = 1×24 + 1×23 + 0×22 + 1×21 + 0×20 

= 16 + 8 + 0 + 2 + 0 

= 2610 

Computer memory is measured in terms of how many bits it can store. Here is a chart for memory 

capacity conversion. 

 1 byte (B) = 8 bits 

 1 Kilobytes (KB) = 1024 bytes 

 1 Megabyte (MB) = 1024 KB 

 1 Gigabyte (GB) = 1024 MB 

 1 Terabyte (TB) = 1024 GB 

 1 Exabyte (EB) = 1024 PB 

 1 Zettabyte = 1024 EB 

 1 Yottabyte (YB) = 1024 ZB 

Octal Number System 
Octal number system has eight digits – 0, 1, 2, 3, 4, 5, 6 and 7. Octal number system is also a 

positional value system with where each digit has its value expressed in powers of 8, as shown here 

− 

 

Decimal equivalent of any octal number is sum of product of each digit with its positional value. 

7268 = 7×82 + 2×81 + 6×80 

= 448 + 16 + 6 

= 47010 

Hexadecimal Number System 
Octal number system has 16 symbols – 0 to 9 and A to F where A is equal to 10, B is equal to 11 

and so on till F. Hexadecimal number system is also a positional value system with where each digit 

has its value expressed in powers of 16, as shown here − 

 

Decimal equivalent of any hexadecimal number is sum of product of each digit with its 
positional value. 

27FB16 = 2×163 + 7×162 + 15×161 + 10×160 

= 8192 + 1792 + 240 +10 

= 1023410 
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Number System Relationship 

The following table depicts the relationship between decimal, binary, octal and hexadecimal 
number systems. 

HEXADECIMAL DECIMAL OCTAL BINARY 

0 0 0 0000 

1 1 1 0001 

2 2 2 0010 

3 3 3 0011 

4 4 4 0100 

5 5 5 0101 

6 6 6 0110 

7 7 7 0111 

8 8 10 1000 

9 9 11 1001 

A 10 12 1010 

B 11 13 1011 

C 12 14 1100 

D 13 15 1101 
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E 14 16 1110 

F 15 17 1111 

ASCII 
Besides numerical data, computer must be able to handle alphabets, punctuation marks, 

mathematical operators, special symbols, etc. that form the complete character set of English 

language. The complete set of characters or symbols are called alphanumeric codes. The complete 

alphanumeric code typically includes − 

 26 upper case letters 

 26 lower case letters 

 10 digits 

 7 punctuation marks 

 20 to 40 special characters 

Now a computer understands only numeric values, whatever the number system used. So all 

characters must have a numeric equivalent called the alphanumeric code. The most widely used 

alphanumeric code is American Standard Code for Information Interchange (ASCII). ASCII is a 7-

bit code that has 128 (27) possible codes. 
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ISCII 
ISCII stands for Indian Script Code for Information Interchange. IISCII was developed to 

support Indian languages on computer. Language supported by IISCI include Devanagari, Tamil, 

Bangla, Gujarati, Gurmukhi, Tamil, Telugu, etc. IISCI is mostly used by government departments 

and before it could catch on, a new universal encoding standard called Unicode was introduced. 

Unicode 
Unicode is an international coding system designed to be used with different language scripts. Each 

character or symbol is assigned a unique numeric value, largely within the framework of ASCII. 

Earlier, each script had its own encoding system, which could conflict with each other. 
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In contrast, this is what Unicode officially aims to do − Unicode provides a unique number for 
every character, no matter what the platform, no matter what the program, no matter what the 
language. 
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Chapter – 7 (Network and Internet) 
A Group of connected computers which communicate each other by sharing the resources form on 

to another is called as computer network. 

Type of networks – 

PAN (Personal Area Network) - A personal area network is a computer network for interconnecting 

electronic devices within an individual person's workspace. 

LAN (Local Area Network) -A local area network is a computer network that interconnects 

computers within a limited area such as a residence, school, laboratory, university campus or office 

building. 

MAN (Metropolitan Area Network) -A metropolitan area network is a computer network that 

interconnects users with computer resources in a geographic region of the size of a metropolitan 

area OR a city. 

WAN (Wide Area Network) - A wide area network is a telecommunications network that extends 

over a large geographic area. Wide area networks are often established with leased 

telecommunication circuits 

Types of Network Topology 
The arrangement of a network that comprises nodes and connecting lines via sender and receiver is 

referred to as network topology. The various network topologies are: 

a) Mesh Topology: 

In a mesh topology, every device is connected to another device via a particular channel.  

  

 

Advantages of this topology:  

It is robust. 

The fault is diagnosed easily. Data is reliable because data is transferred among the devices through 

dedicated channels or links. 

Provides security and privacy. 

Problems with this topology :  

Installation and configuration are difficult. 

The cost of cables is high as bulk wiring is required, hence suitable for less number of devices. 
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The cost of maintenance is high. 

 Star Topology : 

In star topology, all the devices are connected to a single hub through a cable. This hub is the central 

node and all other nodes are connected to the central node. The hub can be passive in nature i.e., not 

an intelligent hub such as broadcasting devices, at the same time the hub can be intelligent known 

as an active hub. Active hubs have repeaters in them.  

  

 

Advantages of this topology :  

If N devices are connected to each other in a star topology, then the number of cables required 

to connect them is N. So, it is easy to set up. 

Each device requires only 1 port i.e. to connect to the hub, therefore the total number of ports 

required is N. 

Problems with this topology :  

If the concentrator (hub) on which the whole topology relies fails, the whole system will crash 

down. 

The cost of installation is high. 

Performance is based on the single concentrator i.e. hub. 

c) Bus Topology : 

Bus topology is a network type in which every computer and network device is connected to a 

single cable. It transmits the data from one end to another in a single direction. No bi-directional 

feature is in bus topology. It is a multi-point connection and a non-robust topology because if 

the backbone fails the topology crashes. 
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Advantages of this topology :  

If N devices are connected to each other in a bus topology, then the number of cables required 

to connect them is 1, which is known as backbone cable, and N drop lines are required. 

The cost of the cable is less as compared to other topologies, but it is used to build small 

networks. 

 Problems with this topology :  

If the common cable fails, then the whole system will crash down. 

If the network traffic is heavy, it increases collisions in the network. To avoid this, various 

protocols are used in the MAC layer known as Pure Aloha, Slotted Aloha, CSMA/CD, etc. 

Security is very low. 

  

d) Ring Topology : 

In this topology, it forms a ring connecting devices with its exactly two neighboring devices. 

A number of repeaters are used for Ring topology with a large number of nodes, because if 

someone wants to send some data to the last node in the ring topology with 100 nodes, then the 

data will have to pass through 99 nodes to reach the 100th node. Hence to prevent data loss 

repeaters are used in the network. 

The transmission is unidirectional, but it can be made bidirectional by having 2 connections 

between each Network Node, it is called Dual Ring Topology. 

  

 

Advantages of this topology:  
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The possibility of collision is minimum in this type of topology. 

Cheap to install and expand. 

Problems with this topology:  

Troubleshooting is difficult in this topology. 

The addition of stations in between or removal of stations can disturb the whole topology. 

Less secure. 

  

Tree Topology : 

This topology is the variation of Star topology. This topology has a hierarchical flow of data.  

  

Advantages of this topology :  

It allows more devices to be 

attached to a single central hub 

thus it decreases the distance 

that is traveled by the signal to 

come to the devices. 

It allows the network to get 

isolate and also prioritize from 

different computers. 

Problems with this topology :   

If the central hub gets fails the entire system fails. 

The cost is high because of cabling. 
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MS-DOS (MICROSOFT DISK OPERATING SYSTEM) 
MS-DOS is a cui (character user interface) operating system developed by Microsoft corporation. 

How to load ms-dos? 

CLICK ON START BUTTON -> ALL PROGRAMS->ACCESSORIES->COMMAND PROMPT 

or 

CLICK ON START BUTTON -> RUN ->TYPE CMD/COMMAND->OK 

Working on Ms- Dos 

To see or change the Date 

Date 

C:\>Date 

The current date is: Sun 12/23/2012 

Enter the new date: (mm-dd-yy) 

To see or change the Time 

Time 

C:\>Time 

The current time is: 18:55:21.05 

Enter the new time: 

To clear the screen 

Cls 

C:\>Cls 

 

File  

Collection of Information is called file. 

File Name- Every computer file having a uniqe  name. File name have to parts Primary name and 

secondary name. Primary name contains 1-8 characters. Secondary name contains 0-3 characters. 

Primary name and secondry name seprated by Dot “.” . 

 

 Example :-     Ram.txt 

 Note :- the caracters you cannot use in filename are 

. / \ ( ) < > + = ; : , ? * 

To create a file 

Copy Con  <File Name> 

Secondary name 

(extension) 

Primary 

name 
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C:\>Copy con lexicon.in 

What is Ms-Dos? 

Ans- Ms-Dos is a CUI Operating System 

Of Microsoft Carporation. 

To Save the file press F6 or Ctrl+z 

^Z 

         1 file(s) copied. 

C:\> 

To see the list of file in the disk 

Dir 

C:\>dir 

 Volume in drive C has no label. 

 Volume Serial Number is 5833-366F 

 Directory of C:\ 

10/18/2012  10:15 PM    <DIR>          Kpcms 

10/18/2012  08:56 AM    <DIR>          lexicon india 

12/23/2012  07:01 PM               122   lexicon.in 

08/29/2012  07:27 PM    <DIR>          lg 

07/14/2009  08:07 AM    <DIR>          PerfLogs 

12/23/2012  02:18 PM    <DIR>          Program Files 

12/23/2012  03:40 PM               118   Sandeep.txt 

12/23/2012  03:37 PM               115   sanjay.txt 

10/30/2012  03:46 PM    <DIR>          sidhu 

               5 File(s)            389 bytes 

              12 Dir(s)   2,009,395,200 bytes free 

C:\> 

To See the Contains of a file 

Type <file Name> 

C:\>type lexicon.in 

What is Ms-Dos? 

Ans- Ms-Dos is a CUI Operating System 
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Of Microsoft Corporation. 

To Save the file press F6 or Ctrl+z 

C:\> 

To change the name of any file 

Ren <Old file name> <New file name> 

C:\>Ren lexicon.in lexicon.bhk 

C:\> 

To make Duplicate copy of any file 

Copy <source file name > <destination file name> 

C:\>Copy lexicon.bhk lexicon.lap 

C:\> 

To erase any file from disk 

Del<file name> 

C:\>del lexicon.lap 

Directory  

To store files in the disk in an organized way, we create places are called directory that places are 

called directory. 

To make a directory  

Md <dir name> 

 C:\>Md Ranchi 

C:\> 

To change directory 

Cd <dir name> 

C:\>Cd Ranchi 

C:\Ranchi> 

Note- 

.  current directory 

.. parrent directory 

 

\ Root Directory (C:, D:, E: etc. are called root directory or drives)  

 

To go to parent directory 

Cd.. 
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C:\Ranchi>cd.. 

C:\> 

To remove directory 

Rd 

C:\>rd Ranchi 

Rules: - 

 Directory must be empty. 

 Given from it parents directory  

To make a file hidden or read only  

Attrib ±code <file name>  

+ =  to set attrib 

-=to remove attrib 

Code:   h(hidden), r(read only) 

C:\>attrib  +r sanjay.txt 

C:\>attrib  -h sanjay.txt 

C:\>attrib  +r sanjay.txt 

C:\>attrib -r sanjay.txt 

To the list of hidden or read only files  

C:\>dir/ah ( To see hidden files) 

C:\>dir/ar ( To see read only files) 

To change the drives 

Drive_letter :   

C:\>D: 

D:\ 

To transfer a file from one location to another. 

Move <source file path> <destination file path> 

Path refers to full name of a file. Such as C:\lexicon\lexicon.in 

C:\>Move c:\lexicon.bhk d:\sandeep.txt  
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Global characters or wild card characters. 

Wild cards are used to perform an ms-dos operation on more than one file at a time. It is also used 

to search files in the disk. There are two wildcards are available:- 

1. ? – A question marks in file name means, it occupy maximum one 

character/letter/number at that position. 

2. * - An asterisk in a file name means, it occupy many character/letter/number at that 

position. 

C:\>Dir a*.* 

Display all the directory and files in the page wise. 

Dir/p 

Display all the directory and files in width wise. 

Dir/w 

To change prompt 

Prompt <text> or Prompt <$character> 

C:\> Prompt LEXICON 

LEXICON Prompt $p$g 

$Q   = (equal sign) 

$$   $ (dollar sign) 

$T   Current time 

$D   Current date 

$P   Current drive and path 

$V   DOS version number 

$N   Current drive 

$G   > (greater-than sign) 

$L   < (less-than sign) 

$B   | (pipe) 

$H   Backspace (erases previous character) 

$E   Escape code (ASCII code 27) 

$_   Carriage return and linefeed 

CHKDSK 

Checks a disk and displays a status report. 

EXIT 

 Quits the CMD.EXE program (command interpreter). 

https://www.youtube.com/junctionofgyan
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FORMAT 

FORMAT command is used to divide a disk into tracks and sectors. 

To Use help command 

Help 

C:\>help 

C:\>help color 

To change the color 

Color [Attr] 

Sets the default console foreground and background colors. 

attr - Specifies color attribute of console output 

Color attributes are specified by TWO hex digits -- the first Corresponds to the background; the 

second the foreground.  Each digit can be any of the following values: 

 

    0 = Black        8 = Gray 

    1 = Blue          9 = Light Blue 

    2 = Green       A = Light Green 

    3 = Aqua         B = Light Aqua 

    4 = Red           C = Light Red 

    5 = Purple      D = Light Purple 

    6 = Yellow      E = Light Yellow 

    7 = White       F = Bright White 

 

C:\>color 70 

C:\> 

 

Batch File 

 To avoid retyping of commands we create a file with .BAT as it’s secondary name and type 

all the commands in that file and save it. 

 Whenever we need those commands to be executed we simply type the file name and press 

Enter. 

 All the commands in that file gets executed one by one automatically.  

Batch file commands 
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Echo on/off- to suppress command displaying on the monitor. 

Echo - to print massage during processing. 

Pause- to stop processing temporarily.  

C:\>Copy con lexicon.bat 

Echo off 

Cls  

Echo ****welcome**** 

Pause 

Cls 

Date 

Cls 

Time 

Cls 

Dir/w 

Pause 

Cls 

Edit 

Dir/w 

Pause 

Cls 

Echo ****The End**** 

Pause 

cls 

F6 

 1 file(s) copied 

C:\> 
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EDIT 

Edit is a text editor program of Ms-Dos. 

To loading Edit:- 

C:\>Edit 

 

 

 

To Activate Menu 

Press ALT+F/E/S/V/O/H 
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Ms- Windows Screen Parts 

 

  
Desktop Icons 

Taskbar Quick 

launch 

Start 

button 
System 

tray 

Show 

Desktop 

Gadgets 
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Ms-Windows is multitasking GUI (Graphical User Interface) operation system software. 

Ms-Windows screen parts- 

1. Desktop 

First screen of windows is called Desktop. 

1.1. My Document- My Document is a desktop folder that provides us with a convenient place 

to sore documents, graphics or other files we want to access quikly. 

When we save a file in a program such as word pad or paint, the file is automatically saved 

in my documents unless we choose a different location. 

1.2. My Computer- My computer contains all the drives and control panels. 

1.2.1. Control panel- Control panel is used to alter the hardware and software settings. 

1.3. Recycle Bin-Recycle bin stores all the deleted files and folders. 

2. Start Button and Taskbar 

2.1. Start Button 

Using the start button, We can accomplish almost any task, we can start program, open 

documents, customize your system, get help, search for items on your computer and more. 

Start Menu Items 

 
2.2. Taskbar 

This is a bar that is usually found at the bottom of our screen. It contains list all open 

programs. 

3. Windows 

A window is typical rectangular area pertaining to an application or a document or a dialog. 
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The title Bar-It is the topmost horizontal bar of each application window and it contains the title of 

the open window 

 The Application Icon -It is the icon representing the open application. 

 Maximize/Restore-This button is used to restore an enlarged window to its previous size or 

vice versa 

 Minimize-This button shrinks the active windows to a button in the taskbar. 

 Close-It is used to close the windows. 

The menu Bar 

The menu bar for an application window is a horizontal bar just below the title bar. The menu bar 

lists the menus available for the application. 

The scroll bars 

Depending on the size of a window, the entire application may not be visible when this happens, the 

window is out filled with vertical and / or horizontal scroll bars. 

 

 

  

 

4.  Icons-icon is a graphic symbol representing a window element  

  

Scroll box 

 

Scroll 

arrows. 
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Working in windows 

Managing file and folder 

A file is a collection of information. Everything stored in a computer is the form of file. 

A folder is a location in which you can store file and other folders  

Creating folder  

1. Right click on the blank screen  

2. Click on new ,and then click on folder 

3. Type the name press enter 

Creating a text file  

1. Right click on the blank screen 

2. Click on new, and then click on New text document 

3. Type the name press enter 

Opening files and folders 

1. Right click on file or folder 

2. Click on open 

Renaming files and folders 

1. Right click on file or folder 

2. Click on rename 

3. Type name and press enter 

To move and copy files and folders 

1. Right click on files and folders 

2. Click on Cut/Copy 

3. Go to appropriate location 

4. Right click on blank space and then click Paste 

To Delete files and folders 

1. Right click on files and folders 

2. Click on delete 

To Create a short cut of a File/folder/application 

1. Right click on desktop 

2. Click on new 

3. Click on Shortcut 

4. Browse the file/folder/application 

5. Select the file/folder/application 

6. Name the shortcut 

7. Click on ok 
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To restore files and folders 

1. Right click on Recycle Bin 

2. Go to file or folder and Right click on it 

3. Click on Restore 

To search files and folders and programs  

1. Click on start button  

2. Type text in search box 

To change date and time 

1. Click on time in system tray  

2. Click on date and time setting 

3. Click on change date and time 

4. Set date and time  

5. And click ok 

 

 

To change wallpaper/screen sever/theme 

1. Right click on blank desktop 

2. Click on personalize 

3. Click on desktop background/Screen sever 

4. Set background/Screen sever  
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Switching Between Open Windows through Windows flip 

1. Flip(Alt+ Tab) 

2. 3D Flip(Window+ Tab)  

 

Using Control panel 

Control panel is used to alter the hardware and software setting of your computer. Windows offer 

two ways to view and use control panel. 

 Classic View. 

 Category view. 

 

Figure 8 : Category View. 
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Figure 15 Classic View 

User Account 

A user account defines the actions a user can perform in Windows. User Accounts lets you create 

or change the password for local user accounts, which is useful when creating a new user account 

or if a user forgets a password. 

 

Program And Feature 

You can uninstall a program from your computer if you no longer use it or if you want to free up space 

on your hard disk. You can use Programs and Features to uninstall programs or to change the 

program's configuration by adding or removing certain options. 

1. Open Programs and Features by clicking the Start button , clicking Control Panel, clicking 
Programs, and then clicking Programs and Features.  

2. Select a program, and then click Uninstall. Some programs include the option to change or 

repair the program in addition to uninstalling it. but many simply offer the option to uninstall. 

To change a program, click Change or Repair.  If you are prompted for an administrator 

password or confirmation, type the password or provide confirmation. 

Mouse 

You can customize your mouse in a variety of ways. For instance, you can swap the functions of 

your mouse buttons, make the mouse pointer more visible, and alter the scroll speed of the mouse 

wheel. 

https://www.youtube.com/junctionofgyan
https://www.youtube.com/junctionofgyan


 

  

P
ag

e4
2

(L
ex

ic
o

n
 In

d
ia

- 
9

6
6

1
2

8
0

0
3

8
) 

 

Key board 

Customizing your keyboard settings helps you work better and more efficiently. By customizing the 

settings, you can determine how long you must press a key before the keyboard character starts 

repeating, the speed at which keyboard characters repeat, and the rate at which the cursor blinks. 

 

date and time 

this panel is used to change the system date and time. 

Display 

You can make the text and other items, such as icons, on your screen easier to see by making them 

larger. You can do this without changing the screen resolution of your monitor or laptop screen. This 

allows you to increase or decrease the size of text and other items on your screen while keeping your 

monitor or laptop set to its optimal resolution. 

Folder Option 

You can change the way files and folders function and how items are displayed on your computer 

by using Folder Options in Control Panel. 

https://www.youtube.com/junctionofgyan
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Open Folder Options by clicking the Start button , clicking Control Panel, clicking Appearance and 

Personalization, and then clicking Folder Options.  

Personalization 

You can change theme, desktop background and screen saver using this option. 

Theme- A theme is a combination of pictures, colors, and sounds on your computer. It includes a 

desktop background, a screen saver, a window border color, and a sound scheme. Some themes might 

also include desktop icons and mouse pointers. 

Desktop Background- This collection of desktop backgrounds—wallpaper—makes it easy to keep 

your PC in tune with your mood. Choose a category and check out a wide selection of free images. 

Pick one you like, and download it. From breathtaking natural wonders, to dazzling works of art—find 

an image that moves you and make it yours.  

Screen Saver - A screensaver is a type of computer program initially designed to prevent phosphor 

burn-in on CRT and plasma computer monitors by blanking the screen or filling it with moving 

images or patterns when the computer is not in use. 

 

Windows accessories program 
The programs which comes with the windows operating system are called windows accessories 

programs. 

 

To access accessories programs 

Start -> all programs->accessories 

 Calculator 

 Command prompt 

 Notepad 

 Paint 

 Run 

 Sniping Tools 

 Windows Explorer 

 WordPad 

 Character Map 
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Notepad 
Notepad is a basic text-editing program and it's most commonly used to view or edit text files. A 

text file is a file type typically identified by the .txt file name extension 

 Click on Start Button, Click on All programs, Click on Accessories, click on Notepad 

Creating a txt file 

1) Click on File Menu(Alt+f) 

2) Click on New(clrl+N) 

Open an Existing file 

1) Click on File Menu(alt+f) 

2) Click on Open 

3) Go to appropriate location 

4) Select File and Click on Open 

To save a file In Notepad 

1) Click on File Menu(alt+f) 

2) Click on Save Button(clrl+s) 

3) Go to appropriate location where you want 

save your file 

4) Type a Name Of File1 on File name box. 

5) And click on Save 

To save a duplicate file of current file 

1) Click on File Menu(alt+f) 

2) Click on Save As Button 

3) Go to appropriate location where you want save 

your file 

4) Type a Name Of File on File name box. 

5) And click on Save 

To Setup a page for printing 

1) Click on File Menu(alt+f) 

2) Click on Page Setup Button  

Print a File 

1)  Click on File Menu(alt+f) 

2) Click on Print Button (Ctrl + p) 

 

                                              
1 The file name can be up to 255 characters And it does not contains following characters   \ / : * ? < > | 
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EDIT MENU (ALT+E) 

To cut, copy, paste or delete text 

1) To cut text so that we can move it to Another location, select the text, and then 

On the Edit menu, click cut. 

2) To find text so that we can paste it in another location, select the text, and then on the Edit 

menu, click Copy. 

3) To paste text we have cut or copied, place the insertion point where we want to paste the text, 

and then on the Edit menu, click paste. 

4) To delete text, select it, and then on the Edit menu click Delete. 

To wrap text to window size  

On the edit menu, click word wrap. Wrappimg text nakes all the text visible on the screen, but it 

doesn’t affect the way text appears when it is printed. 

Adding time and date components 

Move the insertion point to where we want to add the tine and date. On the Edit Menu, click 

Time/Date. (F5) 

Go to specific line( it work without wrap text) 

1) Click on Edit menu 

2) Click on Go To(Ctrl + G)  

3) Enter specific line where you want to go. 

4) Click on Go To button  

Change font Style 

1) Click on Formant menu 

2) Click on Font 

3) Set font style and press ok 

Word Pad 

WordPad is a text-editing program you can use to create and edit documents. Unlike Notepad, 

WordPad documents can include rich formatting and graphics, and you can link to or embed objects, 

such as pictures or other documents. 

To load Word pad 

 Click on Start Button, Click on All programs, Click on accessories, click on WordPad. 

 

 Word 

Pad 

Button 

Quick 

Access Tool 

Word Pad 

Ribbon 
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Creating a  file 

1) Click on WordPad Button  

2) Click on New(CLRL+N) 

Open an Existing file 

1) Click on WordPad Button  
2) Click on Open 

3) Go to appropriate location 

4) Select File and Click on Open 

To save a file  

1) Click on WordPad button  

2) Click on Save Button(Clrl+S) 

3) Go to appropriate location where you want save your file 

4) Type a Name Of File2 on File name box. 
5) And click on Save 

To save a duplicate file of current file 

1) Click on WordPad button  

2) Click on Save As Button 

3) Go to appropriate location where you want 

save your file 

4) Type a Name Of File on File name box. 

5) And click on Save 

To Setup a page for printing 

1) Click on WordPad button  
2) Click on Page Setup Button  

Print a File 

1) Click on WordPad button  

2) Click on Print Button(Ctrl + p) 

Home Tab 

1) Change how text looks in your document 

Select the text that you want to change, and then use the buttons on the Home 

tab in the Font group. 

2) Change how text is aligned in your document 

                                              
2 The file name can be up to 255 characters And it does not contains following characters   \ / : * ? < > | 
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Select the text that you want to change, and then use the buttons on the Home 

tab in the Paragraph group. 

3) Insert the current date 

1) On the Home tab, in the Insert group, click Date and time. 

2) Click the format you want, and then click OK. 

4) Insert a picture 

1) On the Home tab, in the Insert group, click Picture. 

2) Locate the picture that you want to insert, and then click Open. 

5) Insert a drawing 

1) On the Home tab, in the Insert group, click Paint drawing. 

2) Create the drawing that you want to insert and then close Paint. 

View Tab 

1) Increase or decrease the zoom level 

On the View tab, in the Zoom group, click Zoom in or Zoom out. 

2) View the document at its actual size 

 

On the View tab, in the Zoom group, click 100%. 

 

3) Display the ruler 

 

On the View tab, in the Show or hide group, select the Ruler check box. 

 

4) Display the status bar 

 

On the View tab, in the Show or hide group, select the Status bar check box. 

 

5) Change the word wrap settings 

 

On the View tab, in the Settings group, click Word wrap, and then click the setting that you want. 

 

Paint 

Microsoft Paint is a simple raster graphics editor that has been included with all versions of 

Microsoft Windows. The program opens and saves files in Windows bitmap, JPEG, GIF, PNG, and 

single-page TIFF formats. The program can be in color mode or two-color black-and-white, but 

there is no grayscale mode. 

To load Paint 

 Click on Start Button, Click on All programs, Click on accessories, click on Paint 
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SNIPPING TOOL 
Snipping Tool is a Microsoft Windows screenshot utility included in Windows Vista and later. It 

can take still screenshots of an open window, rectangular areas, a free-form area, or the entire screen. 

Snips can then be annotated using a mouse or a tablet, stored as an image file or an MHTML file, 

or e-mailed. 

 

Character Map 
Character Map is a utility included with Microsoft Windows operating systems and is used to view 

the characters in any installed font, to check what keyboard input is used to enter those characters, 

and to copy characters to the clipboard in lieu of typing them.  

 

 

Keystroke – Alt + 0169 = © 

Alt + 0174 = ®  

Windows Explorer 

Windows Explorer is a file manager application that is included with releases of the Microsoft 

Windows operating system from Windows 95 onwards. It provides a graphical user interface for 

accessing the file systems. 
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